Contents

Loading Paper .................................................. 4
Using Special Papers ........................................... 6

Copying a Document or Photo ................................. 8
Placing the Original on the Glass ............................ 8
Copying a Document ............................................. 9
Copying a Photo ............................................... 10
Copying Draft Documents ..................................... 11

Printing From a Memory Card or Digital Camera .......... 12
Printing From a Memory Card ................................ 12
Printing From a Digital Camera .............................. 18

Printing From Your Computer ................................ 19
Printing in Windows .......................................... 19
Printing With a Macintosh .................................... 21

Scanning a Photo or Document ............................... 26
Basic Scanning .................................................. 26
Restoring and Correcting Photos ............................. 27

Maintaining Your All-in-One ................................. 28
Checking the Print Head Nozzles ......................... 28
Cleaning the Print Head ....................................... 29
Checking the Ink Cartridge Status ......................... 30
Replacing Ink Cartridges .................................... 31

Solving Problems .............................................. 36
Checking for Software Updates ............................ 36
Error Indicators ............................................... 37
Problems and Solutions ...................................... 38
Where To Get Help ........................................... 40

Notices ............................................................ 41
Introduction

After you have set up your Epson Stylus® NX200 Series all-in-one as described on the Start Here sheet, turn here to:

- Load paper
- Make a copy of a document or photo
- Print from a memory card or digital camera
- Get the basic steps for printing from your computer
- Scan a document or photo and restore or correct the color, if necessary
- Perform routine maintenance
- Solve simple problems

This book tells you how to do most of these things without ever turning on your computer! Of course, your NX200 Series can do a lot more when you connect it to your Windows® or Macintosh® computer. For additional instructions, see the on-screen Epson Information Center by double-clicking the icon for it on your desktop.

Please follow these guidelines as you read your NX200 Series instructions:

**Warning:**
Warnings must be followed carefully to avoid bodily injury.

**Caution:**
Cautions must be observed to avoid damage to your equipment.

**Note:**
Notes contain important information about your NX200 Series.

**Tip:**
Tips contain hints for better copying, scanning, and printing.
Loading Paper

You can print documents and photos on a variety of paper types and sizes. For details, see page 6.

1. Open the paper support and pull up the extensions. Then open the output tray, pull out the extensions, and raise the stopper.

2. Squeeze the edge guide and slide it left.

**Tip:**
If the feeder guard is in the way, flip it forward.
3. Insert the paper, glossy or printable side up, against the right side and beneath the tab. (Load letterhead or pre-printed paper top edge first.)

You can load up to 120 sheets of plain paper, 80 sheets of matte, or 20 sheets of photo paper. Load other special papers one sheet at a time.

Note:
The type of paper you choose affects the way your printout looks. If you are just making a copy or printing a rough draft, plain paper is fine. However, for the best results, you’ll want to use one of Epson’s special ink jet papers designed for your printer. For example, your photos will look great printed on Epson Premium Photo Paper Glossy (see page 6 for more information).

4. Slide the edge guide against the paper, but not too tightly.

Note:
For instructions on loading envelopes, see your on-screen Epson Information Center.
Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson® ink and paper at Epson Supplies Central™ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041934, S042181, S042174</td>
<td>50, 60, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041935, S042182, S042175</td>
<td>20, 25, 50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041808, S041727</td>
<td>40, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041286, S041667, S042183</td>
<td>20, 50, 25</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041809, S042038</td>
<td>50, 100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141, S041649, S041271</td>
<td>20, 50, 100</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257, S042180</td>
<td>50, 100</td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>----------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Copying a Document or Photo

Follow the instructions in this section to position your originals correctly on the glass and make color or black-and-white copies.

**Placing the Original on the Glass**

1. Open the document cover and place your original face-down on the glass, with the top facing into the front right corner.

   ![Instructions image 1]

   Move the photo or document slightly away from the edges.

2. Close the cover gently so you don't move the original.

   ![Instructions image 2]
Copying a Document

You can copy documents onto letter- or A4-size plain paper or Epson special paper just like a copy machine.

1. Load letter- or A4-size plain paper or Epson special paper.

2. Press the paper size button, if necessary, to select Letter Size Plain Paper.

3. Place your original document on the document table.

4. Press the Copies button to select from 1 to 9 copies. The number is displayed in the Copies window.

   To make 10 to 100 copies, press the Copies button until \( \equiv \) appears in the Copies window. Then load only enough paper for the copies you want to make. For example, for 12 copies load 12 sheets of paper. (Be sure to change this setting back to 1 when you’re finished.)

5. Press the \( \Diamond \) Start B&W (for black-and-white documents) or \( \Diamond \) Start Color (for color documents) to start copying.

If you need to cancel copying, press the \( \Box \) Stop button.

**Note:**
Copies may not be exactly the same size as your original document.
Copying a Photo

You can copy photos onto 4 × 6-inch Epson photo paper (various types available) for borderless photo reprints.

1. Load up to 20 sheets of 4 × 6-inch Epson photo paper.
2. Press the paper size button, if necessary, to select 4"x6" Photo Paper.
3. Place your original photo on the document table.
4. Press the Copies button to select from 1 to 9 copies. The number is displayed in the Copies window.
   To make 10 to 100 copies, press the Copies button until \( \equiv \) appears in the Copies window. Then load only enough paper for the copies you want to make. For example, for 12 copies load 12 sheets of paper. (Be sure to change this setting back to 1 when you’re finished.)
5. Press \( \text{Start Color} \) (for color photos) or \( \text{Start B&W} \) (for black-and-white photos) to start copying. The NX200 Series automatically sizes your photo to fit on the 4 × 6-inch paper you loaded.

   **Note:**
   To create borderless prints, press and hold the \( \text{Start Color} \) or \( \text{Start B&W} \) button for about 5 seconds, until you hear the scanner start to scan your photo.

If you need to cancel copying, press the \( \text{Stop} \) button.

**Note:**
Copies may not be exactly the same size as your original photo.
Copying Draft Documents

You can make quick draft copies of documents on plain paper or Epson Bright White paper. Draft copies have reduced print quality, but they print faster.

1. Load letter- or A4-size plain paper or Epson Bright White paper.
2. Press the paper size button, if necessary, to select Letter Size Plain Paper.
3. Place your original document on the document table.
4. Press the Copies button to select from 1 to 9 copies. The number is displayed in the Copies window.

   To make 10 to 100 copies, press the Copies button until  appears in the Copies window. Then load only enough paper for the copies you want to make. For example, for 12 copies load 12 sheets of paper. (Be sure to change this setting back to 1 when you're finished.)

5. Press and hold the  Stop button as you press either the  Start B&W (for black-and-white documents) or  Start Color (for color documents) to start copying. If you need to cancel copying, press the  Stop button.

Note:
Copies may not be exactly the same size as your originals.
Printing From a Memory Card or Digital Camera

The Epson Stylus NX200 Series all-in-one lets you print photos from:

- Your digital camera’s memory card (see below)
- Your camera itself (see page 18)

Printing From a Memory Card

The NX200 Series lets you print color photos directly from your digital camera’s memory card; just insert it into one of the memory card slots and you’re ready to print.

If your digital camera supports DPOF™ (Digital Print Order Format), you can pre-select the photos you want to print while the card is still in the camera. Then, when you insert the card in the NX200 Series, you can print them.

See these sections:

- “Compatible Cards and Image Formats” on page 13
- “Inserting the Card” on page 14
- “Printing Photos From an Index Sheet” on page 15
- “Printing Photos Pre-selected in Your Camera (DPOF)” on page 17

See the User’s Guide for instructions on copying memory card files between your NX200 Series and a computer or other device.
Compatible Cards and Image Formats

You can use the following types of cards with your NX200 Series:

<table>
<thead>
<tr>
<th>Left slot</th>
<th>Right slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD™</td>
<td>CompactFlash® Type I/I</td>
</tr>
<tr>
<td>SDHC™</td>
<td>Microdrive™</td>
</tr>
<tr>
<td>miniSD™*</td>
<td></td>
</tr>
<tr>
<td>miniSDHC*</td>
<td></td>
</tr>
<tr>
<td>microSD*</td>
<td></td>
</tr>
<tr>
<td>microSDHC*</td>
<td></td>
</tr>
<tr>
<td>MultiMediaCard™</td>
<td></td>
</tr>
<tr>
<td>Memory Stick™</td>
<td></td>
</tr>
<tr>
<td>Memory Stick Duo™*</td>
<td></td>
</tr>
<tr>
<td>Memory Stick PRO™</td>
<td></td>
</tr>
<tr>
<td>Memory Stick PRO Duo™*</td>
<td></td>
</tr>
<tr>
<td>Memory Stick Micro*</td>
<td></td>
</tr>
<tr>
<td>MagicGate™ Memory Stick</td>
<td></td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo™*</td>
<td></td>
</tr>
<tr>
<td>xD-Picture Card™</td>
<td></td>
</tr>
<tr>
<td>xD-Picture Card Type H</td>
<td></td>
</tr>
<tr>
<td>xD-Picture Card Type M</td>
<td></td>
</tr>
<tr>
<td>* Adapter required</td>
<td></td>
</tr>
</tbody>
</table>

The NX200 Series supports image files that meet the following requirements:

<table>
<thead>
<tr>
<th></th>
<th>DCF version 1.0 or 2.0 compliant*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media format</td>
<td>JPEG</td>
</tr>
<tr>
<td></td>
<td>Supports Exif version 2.21</td>
</tr>
<tr>
<td>File format</td>
<td></td>
</tr>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 9200 × 9200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 999</td>
</tr>
</tbody>
</table>

* DCF is the “Design rule for Camera File system” standard.

Note:
You can print only in color when printing directly from a memory card; you cannot print in black-and-white.
**Inserting the Card**

1. Make sure the NX200 Series is turned on.

2. Insert your card into the correct slot as shown (it won't go in all the way). Insert just one card at a time.

The memory card access light flashes and stays lit. Now you can:

- Print an index sheet so you can select which photos to print (see page 15)
- Print photos pre-selected on your camera using DPOF (see page 17)

When you want to remove the card, make sure the memory card access light is not flashing, then pull the card straight out of its slot.

**Caution:**
Do not remove the card or turn off the NX200 Series while the memory card access light is flashing; you may lose data on the card.
Printing Photos From an Index Sheet

You can print an index sheet containing small versions of all the photos on your memory card. Then you can select the photos you want to print by marking them on the sheet and scanning the sheet. The NX200 Series automatically prints them.

Printing an Index Sheet

1. Load several sheets of plain letter- or A4-size paper (see page 4).
2. Insert a memory card in a memory card slot (see page 14).
3. Press the Print Index Sheet button to print the index sheet.

The most recent photos are printed on the first index sheet, up to 30 photos per page.

Note:
If you need to cancel printing, press the Stop button.

Now you can select your photos on the sheet, and scan and print them. See the next section for instructions.
Printing Photos From the Index Sheet

1. Use a dark pen or pencil to fill in the circles on the sheet.

   - Select the paper type and size you want to use.
   - Select **Borderless** or **With Border** layout.
   - If you want to print the date the photo was taken on each photo, fill in the **Print date on photos** circle.
   - Fill in one circle beneath each photo you want to print. The numbers indicate how many copies you want of that photo.
   - If you want to print one copy of all the photos on the index sheet, fill in the **All** circle.

2. Open the document cover.

3. Place the index sheet face-down on the glass, in the lower right corner so that the top of the sheet is aligned against the right edge of the glass.
4. Close the document cover.

5. Load the type of paper on which you want to print your photos, either plain or photo paper.

6. Make sure your memory card is still inserted.

7. Press Print from Index Sheet to start scanning and printing. Wait until printing finishes before printing from any additional index sheets.

   **Note:**
   If you need to cancel printing, press the Stop button.

When you finish printing, you can remove your memory card.

---

**Printing Photos Pre-selected in Your Camera (DPOF)**

If your camera supports DPOF (Digital Print Order Format), you can select the photos you want to print while your memory card is still in your camera. Then you can insert the card in the NX200 Series and quickly print them.

**Note:**
See your camera manual for instructions on selecting photos with DPOF.

1. Insert a memory card containing photos selected with DPOF in a memory card slot. You see Ⓐ (the letter d) in the Copies window.

2. Load the type of paper on which you want to print your photos, either plain or photo paper.

3. Press the paper size button to select the size and type of paper you loaded.
   - If you select Letter Size Plain Paper, the photos print with a white border.
   - If you select 4"x6" Photo Paper, the photos print all the way to the edges (borderless).

4. Press the Start Color button to print your photos.

   **Note:**
   If you need to cancel printing, press the Stop button.
If you have a digital camera that supports PictBridge™ or USB DIRECT-PRINT printing, you can connect it to the NX200 Series and print your photos directly from the camera. Check your camera manual to see if it is compatible. Your photos must be JPEG format and sized from 80 × 80 pixels to 9200 × 9200 pixels.

Note:
Epson cannot guarantee the compatibility of any cameras. Some combinations of paper type, size, and layout may not be supported, depending on your camera and the NX200 Series settings.

1. Before you connect your camera, make sure your NX200 Series is turned on, but not printing.
2. Remove any memory cards from the slots.
3. Connect the USB cable that came with your camera to the USB connector on the front of your NX200 Series.
4. Load the paper on which you want to print your photos (see page 4).
5. Press the paper size button to select the size and type of paper you loaded.
   If you select Letter Size Plain Paper, the photos print with a white border.
   If you select 4"x6" Photo Paper, the photos print all the way to the edges (borderless).
6. Turn on your camera.
7. Follow the instructions that came with your camera to select your photos and settings, and print them.

When you finish printing, turn off your camera and disconnect it from the USB connector on the NX200 Series.
This section describes the basic steps for printing a photo or document stored on your Windows or Macintosh computer. For detailed instructions on printing, see the on-screen User's Guide.

Before you start, make sure you've installed your printer software and connected the NX200 Series to your computer as described on the Start Here sheet.

Tip:
It's a good idea to check for updates to your NX200 Series software (see page 36 for instructions).

Printing in Windows

1. Open a photo or document in an application.
2. Open the File menu and select Print. You see a window like this one:

3. Make sure EPSON Stylus NX200 Series is selected, then click the Preferences or Properties button.
   (If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.)
4. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 25 for details).

Note:
For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab.

5. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

6. For more printing options, click the Advanced tab.

Note:
For more information about print settings, click Help or see your on-screen Epson Information Center.

7. Click OK to save your settings.
8. Click OK or Print to start printing. This window appears and shows the progress of your print job.

Printing With a Macintosh

See the section below for your Mac OS® operating system.

Mac OS X 10.5

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select EPSON Stylus NX200 as the Printer setting.
4. Click the arrow to expand the Print window, if necessary.
5. Select the basic copy and page settings. For borderless photos, choose a Paper Size setting with a Sheet Feeder - Borderless option.

Note:
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window.

6. Choose Print Settings from the pop-up menu, and select the following print settings:

- Choose Print Settings
- Select your paper type (see page 25)
- Select Color or Black Ink Only output
- Select higher quality or faster printing (if available)
7. Choose any other printing options you may need from the pop-up menu. See the on-screen *User’s Guide* for details.

8. Click Print.

9. To monitor your print job, click the printer icon in the dock.

**Mac OS X 10.3 to 10.4**

1. Open a photo or document in an application.

2. Select Page Setup from the File menu. Select the following settings:

   For borderless printing, choose a *Sheet Feeder - Borderless* option in the *Paper Size* list for your paper size (US Letter, 8 × 10 in, 5 × 7 in, or 4 × 6 in).

3. Click OK to close the Page Setup window.
4. Select Print from the File menu. You see a window like this one:

5. Choose Print Settings from the pop-up menu and select the following settings as necessary:

- **Note:** In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

6. Choose any other printing options you may need from the pop-up menu. See your on-screen User’s Guide for details.

7. Click the Advanced button to change additional settings.

- **Note:** For more information on advanced settings click ?.

8. Click Print.
9. To monitor the progress of your print job, click the printer icon in the dock (or click the Print Center icon and double-click Stylus NX200 on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 20) or Media Type (see page 24) setting in your printer software. This tells the NX200 Series what kind of paper you’re using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
Scanning a Photo or Document

You can use your Epson Stylus NX200 Series all-in-one to scan a photo or document and save it on your computer or other device.

You can even restore and correct photographs as you scan (see page 27).

The Epson Scan software provides three scanning modes:

- **Full Auto Mode** scans quickly and easily using automatic settings.
- **Home Mode** previews your image and provides preset options for scanning.
- **Professional Mode** previews your image and provides a full array of tools.

**Note:**
For detailed scanning instructions, see your on-screen *Epson Information Center*.

---

**Basic Scanning**

You can scan from any TWAIN-compliant application using Epson Scan. Or you can start Epson Scan directly from your computer and save your image to a file.

1. Open the document cover and place your original face-down on the glass, in the front right corner, as shown on page 8.
2. Close the cover gently so you don’t move the original.
3. Do one of the following to start Epson Scan:
   - **Windows:** Double-click the **EPSON Scan** icon on your desktop.
   - **Macintosh:** Double-click **EPSON Scan** in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose **Import** or **Acquire**, and select **Epson Stylus NX200 Series**.
4. If the Mode setting in the upper right corner is set to Full Auto Mode, click the Scan button.

If you are in Home or Professional Mode, you see a different Epson Scan settings window. (You can change the mode using the Mode selector in the upper right corner.)

5. If you want to restore faded color in a photo or make other corrections, click Customize. Then follow the instructions below.

6. Click OK. The image is scanned and you see its icon in Windows Explorer or Macintosh Finder.

---

**Restoring and Correcting Photos**

You can automatically transform a faded, dusty, or badly exposed color photo into one with true-to-life color and sharpness as you scan. Use the Color Restoration and Dust Removal options in Epson Scan’s Full Auto Mode. In Home and Professional Mode, you can also select Backlight Correction to remove shadows from images with too much background light.

---

**Full Auto Mode**

Click the Customize button, click Dust Removal and/or Color Restoration, click OK, and click Scan.

Select Auto Photo Orientation to orient your photos based on detected faces, the sky, etc. If your photo is not oriented correctly, turn it off.

---

**Note:**

For more information, see your on-screen Epson Information Center. You can also click Help on the Epson Scan screen for information about all the available settings.

---
Maintaining Your All-in-One

Follow the instructions in this chapter for checking and cleaning the print head nozzles and replacing ink cartridges. To align the print head, if necessary, see your on-screen Epson Information Center.

Caution:
To keep your NX200 Series looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Load letter-size paper in the sheet feeder.
2. Hold down the Stop button as you press the On button. Hold down both buttons until the On light begins to flash, then release the buttons.
3. Check the nozzle check pattern that prints to see if there are gaps in the lines.

Nozzles are clean

Nozzles need cleaning

4. If there are no gaps, the print head is clean. If there are gaps or the pattern is faint, clean the print head as described in the next section.

Cleaning the Print Head

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

Note:
You cannot clean the print head if an ink cartridge is expended or low. You must replace the cartridge first (see page 31).

1. Make sure the NX200 Series is on and the ink light is off.

2. Hold down the Stop button for at least 3 seconds until the On light starts flashing, then release the buttons. The NX200 Series runs a head cleaning cycle, which takes about one minute.

Caution:
Never turn off the NX200 Series during head cleaning or you may damage it.

3. When the On light stops flashing, run a nozzle check (as described on page 28) to verify that the print head is clean.

4. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

Note:
If you don’t see any improvement after cleaning the print head three times, turn off your NX200 Series and wait at least six hours to let any dried ink soften. Then try cleaning the print head again. If quality does not improve, one of the ink cartridges may need to be replaced. If that doesn’t help, contact Epson as described on page 40.

If you do not use your NX200 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

When the red ♦ ink light starts flashing, a cartridge is low on ink. You can continue printing until a cartridge needs replacement. When the red ♦ ink light stays on, you need to replace a cartridge.

**Note:**
You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing or copying.

A window may also appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates retrieved from an Epson website. On a Windows computer that is connected to the Internet, you may see a screen asking if you want to receive these Epson offers the first time you try to print when ink is low. Click **Accept** or **Decline**.

**Note:**
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen *User’s Guide*.

**Tip:**
If a cartridge is more than six months old, print quality may decline. If necessary, try cleaning the print head (see page 29). If printouts still do not look their best, you may need to replace the cartridge.

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Standard Capacity</th>
<th>Moderate Capacity (for light use)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Cyan</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Magenta</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Yellow</td>
<td>69</td>
<td>88</td>
</tr>
</tbody>
</table>
Replacing Ink Cartridges

Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold temperatures, allow them to warm up to room temperature for at least 3 hours before using them.

Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Note:
Leave the expended cartridge installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

1. Turn on the NX200 Series.

   Note:
   If you need to change a cartridge before it’s low or expended (the ink light is neither on nor flashing), run the ink cartridge replacement utility. See the on-screen User’s Guide for details.

2. Open the scanner.
3. Press the \textit{Stop} button. The print head moves to the $\emptyset$ position to indicate which cartridge is low or expended.

\textbf{Caution:}
Do not move the print head by hand; this may damage your NX200 Series. Always press and release the \textit{Stop} button to move it.

4. Press the \textit{Stop} button again.
   - If another cartridge is low or expended, it moves to the $\emptyset$ position. Press the \textit{Stop} button again to see if any more cartridges are low or expended.
   - If no other cartridges are low or expended, the print head moves to the replacement position.
5. Open the cartridge cover.

6. Squeeze the tab on the cartridge and lift it up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

7. Before you open the new cartridge package, shake it four or five times. Then remove it from the package.

**Caution:**
Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.
8. Remove the yellow tape from the bottom of the ink cartridge.

Caution:
Do not remove any other labels or seals, or ink may leak.

9. Insert the new ink cartridge into the holder and push it down until it clicks into place.

10. Once you replace all the cartridges that need replacing, close the cartridge cover and push it down until it clicks into place.
11. Close the scanner.

12. Press the \( \text{Stop} \) button to begin charging the ink. This takes about 2½ minutes. When it’s finished, the \( \text{On} \) light stops flashing and remains on, and the \( \text{ink} \) light goes out.

**Caution:**
Never turn off the NX200 Series while ink is charging or you’ll waste ink. If the \( \text{ink} \) light flashes, press the \( \text{Stop} \) button and press down all the cartridges securely.

**Note:**
If you replaced a cartridge while copying a document or photo, cancel printing and make sure your original is still placed correctly on the document table. Then copy your original again.

If you remove a low or expended ink cartridge, you cannot reinstall and use it.
Solving Problems

If you have a problem with your NX200 Series, check the lights on the control panel to diagnose the cause.

You can also check “Problems and Solutions” on page 38 for basic troubleshooting suggestions, or double-click the User's Guide icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your NX200 Series software. Open your on-screen User's Guide and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canadian).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click Start or , select Programs or All Programs, select EPSON, and click Epson Stylus NX200 Series Driver Update.
## Error Indicators

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>✧ paper light on</td>
<td>Paper is out or multiple pages have fed. Load or reload paper in the sheet feeder, then press one of the ✧ Start buttons to continue.</td>
</tr>
<tr>
<td>✧ paper light flashing</td>
<td>Paper is jammed. Carefully remove the jam, as described on page 39.</td>
</tr>
<tr>
<td>♦ ink light flashing</td>
<td>One or more cartridges have low ink. You can continue printing until a cartridge needs replacement. Check the cartridge status to determine which cartridges are affected (see page 30).</td>
</tr>
<tr>
<td>♦ ink light on</td>
<td>One or more ink cartridges are expended or incorrectly installed. If an ink cartridge is expended, you must replace the cartridge to be able to print. If you just replaced a cartridge and the light is still on, the cartridge is not installed correctly. Press the ♦ Stop button to move the cartridges to the replacement position. Press down on all the installed cartridges, then press the ♦ Stop button to continue.</td>
</tr>
<tr>
<td>✧ paper light flashing I shown in Copies window</td>
<td>The inserted memory card is not supported or does not contain compatible photos. Remove it and insert another card (see page 14).</td>
</tr>
<tr>
<td>✧ paper light flashing ² shown in Copies window</td>
<td>The index sheet is not positioned correctly or is not marked correctly. Check the marks on the sheet, position it correctly, and print it again (see page 16).</td>
</tr>
<tr>
<td>✧ paper light flashing ³ shown in Copies window</td>
<td>The index sheet is not marked correctly. Check the marks on the sheet, position it correctly, and print it again (see page 16).</td>
</tr>
<tr>
<td>✧ paper light flashing ⁴ shown in Copies window</td>
<td>The index sheet you’re printing from does not match the photos on the inserted memory card. Replace the card or the sheet and try again (see page 16).</td>
</tr>
<tr>
<td>✧ paper light flashing ⁵ shown in Copies window</td>
<td>The connected USB hub is not supported. Disconnect the hub.</td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you're having trouble using your NX200 Series.

Printing and Copying Problems

■ Make sure your original is positioned in the front right corner of the glass. If the edges are cropped, move your original away from the edges slightly.

■ Make sure your paper is loaded short edge first and is positioned against the right side with the edge guide against its left side. Don't load paper above the arrow mark inside the edge guide.

■ Make sure the paper size settings are correct for the paper you loaded.

Paper Feeding Problems

■ If paper doesn't feed, remove it from the sheet feeder. Flip through the stack to separate the sheets a little. Then reload the paper against the right side, and slide the left edge guide against the paper (but not too tightly).

■ Do not load too many sheets at once. Load up to 20 sheets of photo paper, 80 sheets of matte paper, or 120 sheets of plain paper. Load other special papers one sheet at a time.

■ Do not load paper with holes punched in it.

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 paper light flashing</td>
<td>The connected USB device is not supported. Disconnect the device and press the 🔄 Stop button to continue.</td>
</tr>
<tr>
<td>⌛ On light flashing 🔄 paper light on 🔵 ink light on ⚪️ shown in Copies window</td>
<td>Parts inside the NX200 Series are at the end of their service life. Contact Epson for help (see page 40).</td>
</tr>
<tr>
<td>🔄 All lights are flashing ⚪️ shown in Copies window</td>
<td>There is a problem with the NX200 Series. Turn it off, wait a few moments, and turn it back on again. If the error is not resolved, contact Epson for help (see page 40).</td>
</tr>
</tbody>
</table>
If paper is jammed, follow these steps:
1. Gently pull out jammed paper from the output tray or sheet feeder.
2. If paper is stuck inside, turn off the NX200 Series.
3. Lift the scanner, remove the jammed paper and torn pieces, lower the scanner, and turn the NX200 Series back on.

**Print Quality Problems**

If you have any problems with the copy or print quality, try these solutions:

- Make sure the document is placed flat against the document table glass and the NX200 Series is not tilted or placed on an uneven surface.
- Load the paper printable side up (usually the whiter, brighter, or glossy side).
- Make sure your paper isn’t damp or curled.
- Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.
- Make sure the type of paper you loaded matches the paper size and paper type settings in your printer software (see page 25).
- For the best print quality, use Epson special paper (see page 6) and genuine Epson ink cartridges (see page 30).
- If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head (see page 29). This unclogs the nozzles so they can deliver ink properly. Run a nozzle check as described on page 28 to see if the print head needs cleaning.
- Clean the print head as described on page 29.
- If you notice jagged vertical lines, you may need to align the print head. See your User's Guide for instructions.
- The ink cartridges may be low on ink. Check your cartridge status (see page 30) and replace cartridges, if necessary (see page 31).
- If a dotted line appears in the image, clean the document table glass with a soft, dry, lint-free cloth (paper towels are not recommended and may permanently scratch the surface), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
■ Product name (Epson Stylus NX200 Series)
■ Product serial number (located on the label in back)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration
■ Description of the problem
Then call:
■ U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Important Safety Instructions

Before using your Epson Stylus NX200 Series all-in-one, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the NX200 Series.
■ Use only the type of power source indicated on the NX200 Series label.
■ Use only the power cord that comes with the NX200 Series. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the NX200 Series near a wall outlet where the plug can be easily unplugged.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the NX200 Series, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the NX200 Series for sufficient ventilation. Do not block or cover openings in the NX200 Series case or insert objects through the slots.
■ Do not place the NX200 Series near a radiator or heating vent or in direct sunlight.
■ Place the NX200 Series on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
■ Make sure the back of the NX200 Series is at least 4 inches (10 cm) away from the wall.
■ Do not open the scanner section while the NX200 Series is copying, printing, or scanning.
■ Do not spill liquid on the NX200 Series.
■ Except as specifically explained in your documentation, do not attempt to service the NX200 Series yourself.
■ Unplug the NX200 Series and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

■ When storing or transporting the NX200 Series, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

■ Do not use aerosol products that contain flammable gases inside or around the NX200 Series. Doing so may cause fire.

**Ink Cartridge Safety Instructions**

■ Keep ink cartridges out of the reach of children and do not drink the ink.

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

■ Do not shake ink cartridges after opening their packages; this can cause leakage.

■ Do not put your hand inside the NX200 Series or touch any cartridges during printing.

■ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the NX200 Series from printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the NX200 Series. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C351D
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson Connection at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit: http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Epson Stylus are registered trademarks, Epson Exceed Your Vision is a registered logomark, the USB DIRECT PRINT logo is a trademark, and Supplies Central is a service mark of Seiko Epson Corporation.

Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2009 Epson America, Inc. 3/09